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HUD Navigation System

Unity Asset Store Link:

https://assetstore.unity.com/packages/slug/103056

Documentation:

https://docs.sickscore.games/hud-navigation-system

Youtube Channel:

https://www.youtube.com/@SickscoreGames

https://assetstore.unity.com/packages/slug/103056
https://assetstore.unity.com/packages/slug/103056
https://docs.sickscore.games/hud-navigation-system
https://docs.sickscore.games/hud-navigation-system
https://www.youtube.com/@SickscoreGames
https://www.youtube.com/@SickscoreGames
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Getting Started
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Installation
How to install the HUD Navigation System and get it to work properly within your

project.

Import HNS into your existing project or start a new one. If you‘re updating from a

previous version, it might be necessary to delete the old folder before you import

the package.

You'll find all package contents within the folder Sickscore Games > HUD

Navigation System.

The built-in Quick Setup is the most simple way to get started with HNS.

You'll find the Quick Setup in the Unity main menu:

Window > Sickscore Games > HUD Navigation System > Quick Setup Window

Simply assign your Player Controller (the Transform, which represents your player)

and your Player Camera (in most cases, this is the main camera). The Quick Setup

will do the following tasks automatically for you:

1. Adds mandatory scripts to your player controller and camera

2. Creates a new GameObject with the HUD Navigation System component

3. Adds the HUD Navigation Canvas prefab to your scene

📦  Import Asset

⚡  Quick Setup
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Example Content
Explore the example content to see how things work, or use it as a start for

customization.

You'll find all example contents within the folder Sickscore Games > HUD

Navigation System > _Examples. Simply copy e.g. HUD prefabs and adjust things as

you like.

Examples are a good starting point for customization.

• Example Scenes: It's always good to play around in our example scenes before

you integrate HNS into your own project.

• Example Settings: Some Element Settings used in our example scenes, which

are shared between multiple HUD Navigation Elements.

• HUD Prefabs: Here you'll find the example prefabs for the different features of

HNS. These are used in our example scenes. It's a good practice to copy them

and adjust them to your needs.

• Scene Configs: Used in our example scenes. You can always create your own 

Scene Configurations to adjust settings between different scenes.

• Scripts: Some example scripts used in our example scenes. It might be worth

checking some of them for reference. You can find more example scripts within 

_Examples > Example Scene > Scripts.

• Textures: Some example textures used in our example scenes. You're allowed

to use all textures and icons for your own projects aswell!

🧩  Example Content
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Support / Feedback
Facing a problem? Need help customizing HNS? Missing a feature?

Just drop us a message  with your Invoice #, a brief description of your issue and

maybe some screenshots and/or videos as reference.

We receive a large amount of support mails, so please give us time to check your

request and write back to you😉

Having thoughts on how to improve HNS even further? Drop us a message  with a

brief description of your idea and we'll check, if it fits into the system.

📨  E-Mail Support

💡  Feature Requests

mailto:contact@sickscore.games
mailto:contact@sickscore.games
mailto:contact@sickscore.games
mailto:contact@sickscore.games


8

FAQ's
Frequently Asked Questions

Currently VR/XR is not supported, because the HNS canvas runs in screen space.

We're already working on an addon for HNS, which already supports most of the

features of HNS. A working beta will be released to the store once we've integrated

all features of the main asset. Stay tuned!

2D is not supported "out-of-the-box", but we have a few customers, which

successfully use HNS in their 2D/2.5D games. This mostly depends on the

individual setup of your project. Please contact us for further advice, before you

purchase HNS.

It should be self-explanatory, but we can't provide everyone with free copies of our

addons :)

We have only a handful of free vouchers available each year, so we exclusively give

them out to students (with legal documents / proof of study).

That's actually really easy to accomplish with the Scene Manager. Just make sure

you've enabled the Don't Destroy On Load setting on the HUD Navigation System

and let the scene manager do the rest. For e.g. menu scenes, where you don't need

HNS, simply disable the system on these scenes with the Disabled In Scene option.

Can I use HNS for my VR/XR project?

Is this asset also suitable for 2D / 2.5D games?

Can I get a free voucher for your assets?

How to use HNS in an environment with multiple scenes?
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HUD Navigation System



10

Component Info
HUD Navigation System - Overview

This is the main component of HNS, which is used to enable/disable the different

features of HNS and holds most of the global settings.

HUD Navigation System
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Settings
Component configuration options

The HUD Navigation System component has a ton of settings, which offers a

variety of possibilities for your project.

We provide a tooltip for almost every setting, just hover them with your mouse pointer

in the unity editor.

• Player Transform: Assign your Player Controller (the Transform, which

represents your player). You can also add the HNSPlayerController component

to your player, to dynamically assign this setting.

• Player Camera: Assign your Player Camera (in most cases, this is your main

camera). You can also add the HNSPlayerCamera component to your player

camera, to dynamically assign this setting.

• Enabled / Active: If enabled, the system will start automatically. This setting can

be changed at runtime to e.g. temporarily disable HNS.

• Rotation Reference: HNS will use the rotation of this transform for it's

calculations.

• Update Mode: Depending on your project, you might have to change this

setting, if the icon positioning is not synced with your character movement.

• Don't Destroy On Load: By default, HNS will automatically persist between

scene changes. You can globally disable this behavior with this setting. Note:

You then have to manually include HNS again, if you change scenes!

⚙️  Settings

General Settings

System Settings
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• Radar Mode: You can switch the mode to change the behavior of the radar.

Select the mode, which fits best to your project.

• Radar Zoom: Controls the overall zoom of the radar. The higher the value, the

higher the virtual drone floats above the player. :)

• Radar Radius: Radius of the radar in meters/units. Elements outside this radius

will be displayed on the border of the radar.

• Radar Radius (Border): Border radius in meters/units. Elements outside this

radius will be hidden on the radar.

• Enable Height System: Enable the height based system for each element inside

the radar. If an element is physically above or below a certain distance, it will

show an arrow above/below the element inside the radar.

◦ Min. Distance Above: Minimum distance upwards to activate the element's

ABOVE arrow.

◦ Min. Distance Below: Minimum distance downwards to activate the

element's BELOW arrow.

◦ Show Debug Gizmos: If enabled, it will draw two planes above and below

the player, which indicate the distance of the height system above and

below the player.

▪ Gizmo Size: Defines the size of the Debug Gizmos.

▪ Gizmo Color: Defines the color and opacity of the Debug Gizmos.

• Compass Bar Radius: Radius of the compass bar in meters/units. Elements

outside this radius will be hidden on the compass bar.

• Indicator Radius: Radius of the indicators in meters/units. Indicators of

elements outside this radius will be hidden.

Radar Settings

Compass Bar Settings

Indicator Settings
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• Indicator Hide Distance: Controls the distance in meters/units at where

indicators are automatically hidden, if your player comes closer to the element.

Set the value to 0 to disable auto-hide on your indicators.

• Enable Offscreen Indicators: If enabled, indicators will stick to the borders of

the screen, if they're currently not visible on screen.

◦ Screen Border: Controls the distance of your offscreen indicators to the

screen borders. A higher value increases the distance to the border.

• Enable Distance Scaling: If enabled, the indicators will scale by distance within

the defined scale radius.

◦ Scale Radius: Indicators inside this radius will be scaled by distance. Value

must be lower or equal to the actual indicator radius.

◦ Minimum Scale: Controls the minimum scale of indicators affected by the

distance scaling functionality.

• Enable Distance Fading: If enabled, the indicators will fade by distance within

the defined fade radius.

◦ Fade Radius: Indicators inside this radius will be faded by distance. Value

must be lower or equal to the actual indicator radius.

◦ Minimum Opacity: Controls the minimum opacity of indicators affected by

the distance fading functionality. Set the value to 0 to completely fade-out

indicators.

• Minimap Profile: Assign the map profile you want to use for the minimap. For

more informations on how to generate a map profile, follow the instructions in

the map profile documentation.

• Minimap Mode: You can switch the mode to change the behavior of the

minimap. Select the mode, which fits best to your project.

• Minimap Scale: Controls the overall scale of the minimap. Decrease the value

to zoom out the minimap and show more area around the player.

• Minimap Radius: Radius of the minimap in meters/units. Elements outside this

radius will be displayed on the border of the minimap.

• Show Minimap Bounds: If enabled, it will draw a cube which scales to the size

of your minimap bounds. Can be useful to debug your minimap profiles.

Minimap Settings
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◦ Gizmo Color: Defines the color and opacity of the minimap bounds cube.

• Enable Height System: Enable the height based system for each element inside

the minimap. If an element is physically above or below a certain distance, it will

show an arrow above/below the element inside the minimap.

◦ Min. Distance Above: Minimum distance upwards to activate the element's

ABOVE arrow.

◦ Min. Distance Below: Minimum distance downwards to activate the

element's BELOW arrow.

◦ Show Debug Gizmos: If enabled, it will draw two planes above and below

the player, which indicate the distance of the height system above and

below the player.

▪ Gizmo Size: Defines the size of the Debug Gizmos.

▪ Gizmo Color: Defines the color and opacity of the Debug Gizmos.
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HUD Navigation Canvas
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Component Info
HUD Navigation Canvas - Overview

This is the 2D canvas prefab, which holds the UI elements for each feature of HNS.

This prefab can simply be copied and customized to fit your needs.

HUD Navigation Canvas
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Settings / UI References
Component configuration options

The HUD Navigation Canvas is controlled by the settings of the HUD Navigation

System component. This component is used to link/assign the different UI

References to the system.

HNS needs to know, where to find the different UI elements inside your UI Canvas.

Each feature needs specific UI elements to work properly, so make sure to correctly

assign them.

The most simply way to get started is to duplicate the canvas prefab and customize it

to your needs. You'll find the prefab in the prefabs folder:

Sickscore Games > HUD Navigation System > Resources > Prefabs.

• Panel: The parent transform, which holds all UI components for this feature.

• Radar: The actual radar transform, which has the image of your radar.

• Player Indicator: A transform, which represents the icon/location of your player.

• Element Container: The container transform, which holds all instantiated

elements.

• Panel: The parent transform, which holds all UI components for this feature.

⚙️  Settings

⚓  UI References

Radar References

Compass Bar References
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• Compass: The actual compass transform, which has the image of your

compass.

• Element Container: The container transform, which holds all instantiated

elements.

• Panel: The parent transform, which holds all UI components for this feature.

• Element Container: The container transform, which holds all instantiated

elements.

• Panel: The parent transform, which holds all UI components for this feature.

• Map Mask Image: The parent transform of the map container, which has an

image mask component attached. The image mask will clip the minimap and

hides the borders of the map texture.

• Map Container: The container transform for all instantiated map layers.

• Player Indicator: A transform, which represents the icon/location of your player.

• Element Container: The container transform, which holds all instantiated

elements.

Indicator References

Minimap References
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HUD Navigation Element
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Component Info
HUD Navigation Element - Overview

Assign this component to each element you want to track with HNS. HUD

Navigation Elements are designed to be instantiated at runtime, so you can

add/remove new elements at any time. Once a GameObject with this component

attached gets removed from the scene, HNS will automatically get notified and will

remove the element from the collection.

HUD Navigation Element
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Settings
Component configuration options

Most of the settings on the HUD Navigation Element component are used to

override the default settings defined by the HUD Navigation System component.

This way, you can define different types of elements, which derive from the default

settings, but behave different from each other.

If you plan to create a lot of elements of the same type (e.g. item pick-ups), it's a good

practice to use HUD Navigation Element Settings to share your settings between

multiple elements and change them at a single place.

• Settings Asset: (optional) Assign an Element Settings asset to configure this

element based on the settings of the asset.

• Radar / Compass Bar / Indicator / Minimap Prefab: Assign an UI Prefab for

each feature you want to use on this element.

• Hide In Radar: If enabled, the element will be hidden within the radar.

• Ignore Radius: If enabled, the element will always be visible within the radar,

even if it's outside the defined radius. Useful for e.g. quest markers!

• Rotate With GameObject: If enabled, the element will rotate within the radar,

depending on it's GameObject's rotation.

• Enable Height System: If enabled, the radar height system will be activated on

this element.

⚙️  Settings

General Settings

Radar Settings
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• Hide In Compass Bar: If enabled, the element will be hidden within the compass

bar.

• Ignore Radius: If enabled, the element will always be visible within the compass

bar, even if it's outside the defined radius. Useful for e.g. quest markers!

• Enable Distance Text: If enabled, the distance text will be activated on this

element. It will show the current distance to the player next to the element.

◦ Text Format: Defines the format of the distance text. "{0}" will be

automatically replaced with the actual distance value.

• Show Indicator: If enabled, the indicator for this element will be visible. Make

sure, the indicator feature is enabled on the HUD Navigation System

component.

• Show Offscreen Indicator: If enabled, the offscreen indicator for this element

will be visible.

• Ignore Radius: If enabled, the indicator for this element will always be visible,

even if it's outside the defined radius. Useful for e.g. quest markers!

• Ignore Hide Distance: If enabled, the indicator for this element will ignore the

defined hide distance. Useful for e.g. item pick-ups!

• Ignore Distance Scaling: If enabled, the indicator for this element will not be

affected by the distance scaling setting.

• Ignore Distance Fading: If enabled, the indicator for this element will not be

affected by the distance fading setting.

• Enable Distance Text: If enabled, the distance text will be activated on this

indicator. It will show the current distance to the player next to the indicator.

◦ Show Offscreen Distance: If enabled, it will also show the distance text on

the offscreen indicator.

◦ Onscreen / Offscreen Text Format: Defines the format of the onscreen /

offscreen distance text. "{0}" will automatically be replaced with the actual

distance value.

Compass Bar Settings

Indicator Settings
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• Hide In Minimap: If enabled, the element will be hidden within the minimap.

• Ignore Radius: If enabled, the element will always be visible within the minimap,

even if it's outside the defined radius. Useful for e.g. quest markers!

• Rotate With GameObject: If enabled, the element will rotate within the minimap,

depending on it's GameObject's rotation.

• Enable Height System: If enabled, the minimap height system will be activated

on this element.

Minimap Settings
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Element Settings
Component configuration options

If you plan to create a lot of elements of the same type (e.g. item pick-ups), it's a

good practice to use Element Settings to share your settings between multiple

elements and change them at a single place.

The settings of the Element Settings asset are identical to the settings of the HUD

Navigation Element component. You can find the documentation here.

To create new Element Settings, right click in your project window and select:

Create > Sickscore Games > HUD Navigation System > New Element Settings

It's easy to create an Element Settings asset from an existing HUD Navigation

Element. Simply create a new Element Settings asset and assign the GameObject

with the existing HUD Navigation Element component to the Copy From field and

click on Copy Settings. All existing settings on the Element Settings asset will be

replaced!

⚙️  Element Settings

🗂️  Copy Settings
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UI Prefabs
Create your own UI prefabs and customize the look and feel!

HNS needs to know, where to find the different UI elements on your marker. Each

feature needs specific UI elements to work properly, so make sure to correctly

assign them.

The most simply way to get started is to duplicate any UI prefab and customize it to

your needs. You'll find the prefab in the prefabs folder:

Sickscore Games > HUD Navigation System > _Examples > HUDPrefabs.

• Icon: The main icon for this element

• Arrow Above: The icon used as the upwards arrow for the height system

HNS Radar Prefab
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• Arrow Below: The icon used as the downwards arrow for the height system

• Icon: The main icon for this element

• Distance Text: The text reference used for the distance text.

• Onscreen Rect: The parent transform of the onscreen indicator

• Onscreen Icon: The main onscreen icon for this element.

• Onscreen Distance Text: The text reference used for the offscreen distance

text.

• Offscreen Rect: The parent transform of the offscreen indicator

• Offscreen Pointer: The pointer image used for the offscreen indicator.

• Offscreen Icon: The main offscreen icon for this element.

• Offscreen Distance Text: The text reference used for the offscreen distance

text.

• Icon: The main icon for this element

• Arrow Above: The icon used as the upwards arrow for the height system

• Arrow Below: The icon used as the downwards arrow for the height system

Custom Transforms are an easy way to add custom logic to HUD Navigation

Elements. We use this mechanic in our example scenes to create the item pick-up.

HNS Compass Bar Prefab

HNS Indicator Prefab

HNS Minimap Prefab

Custom Transforms
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Custom Transforms can be used to include custom logic to HUD Navigation Elements,

such as item pick-ups, interactions, ...

• Name: Enter a unique name, which will be used to access this transform in code

• Transform: Assign the transform with your custom logic

Show/hide a custom icon on the indicator, if an element is within the defined radius.

How to get this example to work:

1. Add a custom transform to your indicator UI Prefab

2. Your Custom Transform must be named "customIcon" (see code)

3. Create a new C# script and copy&paste the code below

4. Select the HUD Navigation Element or Element Setting you want to use

5. Assign these methods to their corresponding Events:

OnEnterRadius: OnIndicatorEnterRadius()

OnLeaveRadius: OnIndicatorLeaveRadius()

Settings

Code Example
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using UnityEngine;
using SickscoreGames.HUDNavigationSystem;

public class CustomTransformCallbackScript : MonoBehaviour
{

public void OnIndicatorEnterRadius (HUDNavigationElement element, 
NavigationElementType type)

{
ShowCustomIndicatorTransform(element, type, true);

}

public void OnIndicatorLeaveRadius (HUDNavigationElement element, 
NavigationElementType type)

{
ShowCustomIndicatorTransform(element, type, false);

}

void ShowCustomIndicatorTransform (HUDNavigationElement element, 
NavigationElementType type, bool visible)

{
// we're only interested in indicator events
if (!type.Equals(NavigationElementType.Indicator))

return;

// check if indicator exists
if (element.Indicator != null)
{

// show/hide our custom icon, if it exists
Transform customIcon = 

element.Indicator.GetCustomTransform("customIcon");
if (customIcon != null)

customIcon.gameObject.SetActive(visible);
}

}
}
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Text References
Use any UI text component or asset you prefer

This component should be added to every UI GameObject that needs to display or

interact with text. By default it is used for distance texts, but it can also serve as a

flexible entry point for your own scripts to modify or control UI text elements.

The system uses text adapters internally, allowing it to support multiple text

component types without additional setup. Out of the box HNS supports legacy UI

text and TextMeshPro text, but you can easily create your own text adapters.

To see the component in action, check out the example prefabs:

Sickscore Games > HUD Navigation System > _Examples > HUDPrefabs

Important for TextMeshPro Support:

Depending on your version of Unity and TextMeshPro, you may need to enable

support by adding TMP_PRESENT  to your project’s scripting define symbols.

To do this, go to Edit → Project Settings → Player, then under Other Settings, locate

the Scripting Define Symbols field. Add TMP_PRESENT  there. If the field already

contains entries, separate them with a semicolon (e.g., 

EXISTING_SYMBOL;TMP_PRESENT ).
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Text Adapters
Used by text references to update text on UI components

Text adapters work behind the scenes and typically require no user interaction. It is

only relevant for advanced scenarios or when using unsupported custom text

components.

Check out the default text adapter scripts:

Sickscore Games > HUD Navigation System > Scripts > Utilities > Adapters.

Need support for a custom text component? No problem.

Creating your own text adapter is straightforward:

• Implement the IHNSTextAdapter  interface

• Use the SetText  method to update your custom text component

This allows you to seamlessly integrate any text solution with the HNS system.

If you’re using a UI text component that isn’t supported yet, please let us know! We’d

be glad to include a suitable text adapter in a future update for everyone to use.

Create Your Own Text Adapter

// HNSTextAdapter_ThirdParty.cs

using SickscoreGames.HUDNavigationSystem;
using UnityEngine;

public class HNSTextAdapter_ThirdParty : MonoBehaviour, IHNSTextAdapter
{
    public void SetText(string text)
    {
        Debug.Log(text);
    }
}
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Events
Interact with HUD Navigation Element during runtime.

Events give you the ability to directly interact with HUD Navigation Elements when

certain events happen during runtime. This way you could for example play an

audio track, if an element (e.g. enemy) appears on screen.

🚀  Events

public void OnElementReady(HUDNavigationElement element)
{
    // Fires directly after the element got initialized and is ready.
    // It's safe to interact with the element after this event has fired.
}

public void OnAppear(HUDNavigationElement element, NavigationElementType 
type)
{
    // Fires directly when the element appears on screen.
    // This event will fire for each feature individually!
    // Use the type parameter to check, which feature fired this event.
}

public void OnDisappear(HUDNavigationElement element, 
NavigationElementType type)
{
    // Fires directly when the element disappears from the screen.
    // This event will fire for each feature individually!
    // Use the type parameter to check, which feature fired this event.
}

public void OnEnterRadius(HUDNavigationElement element, 
NavigationElementType type)
{
    // Fires directly when the element enters the defined radius.
    // This event will fire for each feature individually!
    // Use the type parameter to check, which feature fired this event.
}
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public void OnLeaveRadius(HUDNavigationElement element, 
NavigationElementType type)
{
    // Fires directly when the element leaves the defined radius.
    // This event will fire for each feature individually!
    // Use the type parameter to check, which feature fired this event.
}
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Scene Manager
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Component Info
HUD Navigation Scene Manager - Overview

The Scene Manager is an essential component, if you're working within an

environment with multiple scenes. With the Scene Manager, you can simply create 

Scene Configurations for your different scenes, or disable HNS completely on e.g.

menu scenes.

HUD Navigation Scene Manager
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Settings
Component configuration options

• Disabled In Scene: If checked, HNS will be completely disabled within this

scene. Useful for e.g. menu scenes.

• Scene: Assign the scene you want to configure.

• Config: Assign the Scene Configuration you want to use for this scene.

Take a look at the Example Scenes to see the Scene Manager in action!

⚙️  Settings
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Scene Configurations
Component configuration options

Scene Configurations are used by the Scene Manager to apply different settings for

each scene. With Scene Configurations you can override every setting of HNS and

completely change the behavior for individual scenes.

To create a new Scene Configuration, right click in your project window and select:

Create > Sickscore Games > HUD Navigation System > New Scene Configuration

🎯  Scene Configuration
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Map Profiles
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Component Info
Map Profiles - Overview

Map Profiles store the rendered (mini)map texture as well as it's corresponding map

bounds. To create a new Map Profile, you have to use the Map Texture Creator.

Map Profile
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You can add Custom Layers to any Map Profile, which you can access by code at

runtime.

Custom Layers can be used to include custom logic to your (mini)map, such as

day/night mode, cave systems, heat maps, etc...

• Name: Enter a unique name, which will be used to access this layer in code

• Texture: Assign your custom layer texture. Make sure it has the same

dimensions as the map texture!

• Enabled: If checked, the custom layer is enabled and can be accessed by code.

Toggle a custom layer's visibility by pressing the "F" key.

Custom Layers

Settings

Code Example
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using UnityEngine;
using SickscoreGames.HUDNavigationSystem;

public class CustomLayerExample : MonoBehaviour
{

private HUDNavigationSystem _HUDNavigationSystem;

void Start ()
{

_HUDNavigationSystem = HUDNavigationSystem.Instance;
}

void Update ()
{

// check if the 'F' key was pressed
if (Input.GetKeyDown(KeyCode.F) && 

_HUDNavigationSystem.currentMinimapProfile != null)
{

// get custom layer from the current map profile
GameObject customLayer = 

_HUDNavigationSystem.currentMinimapProfile.GetCustomLayer("customLayerNam
e");

if (customLayer != null)
customLayer.SetActive(!customLayer.activeSelf);

}
}

}
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Create Profiles
How to generate map textures and create map profiles.

The Map Texture Creator is used to render a static texture of your whole map and

create a Map Profile out of it. The final texture can be edited in an image program to

customize the look and feel of your (mini)map.

Make sure to hide all elements, which should not appear on the final map texture,

before you create the Map Profile.

You'll find the Map Texture Creator in the Unity main menu:

Window > Sickscore Games > HUD Navigation System > Map Texture Creator

Map Texture Creator
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Once you open the Map Texture Creator, a new GameObject called 'HNS

MapTextureCreator' will be automatically added to the scene, which holds all

necessary components.

The process of creating a new Map Profile is pretty straightforward:

1. Enter a name for your new MapProfile

2. Select a fitting texture size.

3. Adjust the bounding box of your map. Use the box handles to modify the size

within the scene view.

4. (optional) Assign your terrain / level mesh to automatically adjust the size of the

bounding box. With the Scale Multiplier you can manually fine-tune the size of

the generated bounding box.

Once the Map Profile is created, it will be highlighted in the project window and is

ready to be assigned to the HUD Navigation System component or to a Scene

Configuration.

🎚️  Usage


